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Chapter 1: Introduction

This chapj:er provides general information about the
Datacard” PB8500" Passport Issuance system.

System Overview

The PB8500 passport issuance system has a series of modules that work
together to complete the personalization of elements on a passport.

Available modules are defined in the following table.

A system may contain duplicate modules or none of certain modules.
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Module

Description

System Controller

The Controller contains the primary computer that controls
the function of the individual modules in the system and is
also the primary interface point for the operator. It includes
the hardware necessary to power on and interact with the
modules in the system.

Each system has a dongle plugged into the Controller

computer. The dongle needs to be in place for the system to
work.

Passport Input

The Passport Input module—always the first module in a
system—feeds booklets into the system from a stack. A
system can have multiple Input modules to hold more
booklets or multiple types of booklet stock.

Booklet Opening

Page Turning

The Page Turning Module opens a booklet to a user-
specified page for downstream processing by other
modules. The module contains a page confirmation camera
to verify that the booklet is opened to the correct page.
Every system must have at least one Booklet Leafing
module near the Input module. Optional Leafing modules
installed throughout the system can open a booklet to other
pages during processing.

Multi-Book Chip

Laser 450G

The Laser 450G module (with a Class 1 laser) have updated
electronics and cables to work with the new 50W laser
interface. They engrave a plastic page in a booklet for
secure, forgery-resistant personalization. The module is
capable of tilt-axis engraving for an even higher level of
security. Vision registration allows precise alignment
between engraved elements and preprinted elements on
the page. The PB8500 system can support multiple Laser
module for higher throughput.

Plasma Pre-treat

Pretreatment of the booklet surface is used to increase the
booklet surface energy and improve the wetting and
adhesive properties of the polymer materials.
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Module

Description

Single Passport
Buffer

This module is used to synchronize multiple Laser Engraving
modules in one system to increase throughput when using
teamed (ganged) engraving. Single Passport Buffer
modules must be installed in pairs except when the module
is directly before a Booklet Closing module.

Drop On Demand
(DoD)

The Color Inkjet Printing module uses pigment to print 1200
dpi full-color, tonal, or black and white images and text on
the paper pages of a passport booklet. Vision registration
allows precise alignment to preprinted elements or the edge
of the page.

Secure Overlay

The Secure Overlay module applies a protective coating to
the surface of the passport booklet page. The thin film
overlay serves as a protective barrier for personalized data
printed on the page and can have holographic or other
designs for protection from tampering.

Quality Assurance

The Quality Assurance module captures digital images of
the horizontal and/or vertical page of a booklet as it passes
through the system. It can also verify the chip encoding in
the eBook and close the booklet before transporting it to
the next module.

Booklet Closing

The Booklet Closing module closes the booklet after all
personalization is complete, and then passes it to the
Output module. This module is not needed when the system
includes the Quality Assurance module or the Contactless
Chip module.

Passport Output

The Passport Output module—always the last module in the
core system—stacks booklets after processing. The module
contains a primary stack for completed booklets and a
secondary stack for rejected booklets. The system can have
multiple Output modules to hold more booklets or to group
booklets in separate stacks.
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Expansion Kits

The following kits are included in your shipment automatically if your
configuration requires additional cooling fans or power inlets.

Additional Cooling Fans

Larger systems may require an additional cooling fan in the Output module.
The cooling fan is available as an installation kit. This kit is shipped with a
system or additional modules if one is required.

Auxiliary AC Power Inlet

The auxiliary AC power inlet is shipped with expansions that exceed the power
limit. Refer to the kit for installation instructions.

Each power inlet and power cord requires a dedicated power drop
with a 15-amp breaker (U.S.) or 16-amp breaker (non-U.S.).
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Specifications and Requirements

System specifications and site requirements are as follows.

Electrical and Environmental Specifications

Operator’'s Guide

Electrical, Operating, and Storage
Refer to the PB8500 Passport Issuance System data sheet on the Datacard
website (www.entrust.com).

Power Consumption

The power consumption of the system is the sum of the power consumption
of the Controller and all of the modules in the system. To see the maximum
current draw for each module, refer to the PB8500 Passport Issuance
System data sheet on the Datacard website (www.entrust.com).

Permissible Current Load

Because the system is modular, it is possible to exceed the permissible load
on the main Controller power cord. If the calculated load on the Controller
power cord or an auxiliary power cord exceeds 12 amps, add more power
inlets and cord(s) to the system.

Electrostatic Discharge Susceptibility

A system can withstand an electrostatic discharge of 15 kV, 330 pF storage,
and 1.5 kW series resistance in tests simulating a human discharge to the
outer surface of the machine. This does not include direct discharge on
printed circuit boards.

Audible Noise

The audible noise level of a system is dependent on the installed modules
and passport personalization data. A system with Controller, Passport Input,
Leafing, Inkjet, Overlay, and Passport Output modules is measured as
follows.

Front Bystander 65.5 dBA to 68.0 dBA
Position
Front Operator 67.5 dBA to 69.5 dBA
Position

Measurements are sound pressure measurements with a handheld
sound meter at the front bystander (1.0 meter from machine, 1.5
meters high) or operator (0.25 meter from machine, 1.5 meters high)
positions per ANSI S12.10-1985, Section 11. All measurements are
averages over 60 seconds (60 L equiv.).


http://www.entrust.com
http://www.entrust.com
http://www.entrust.com
http://www.entrust.com
http://www.entrust.com

Physical Requirements

The following section contains the physical site requirements needed for a

PB8500 system.

Floor Space

The floor space required to install the system is dependent on the number and
type of modules included. To determine how much floor space is required,

calculate the following:

1. Controller width + [number of input and output modules x input/output
width] + [number of inkjet modules x inkjet width)] + (number of standard
modules x standard width) = Total width of system

2. Total width x 33.8-inch (85.9-cm) depth = Floor space used by system

3. Floor space used + 36-inch (45.72-cm) clearance on all sides for service
access and airflow = Total floor space

The floor must be level and flat within = 0.1 inch per foot (1 mm per 10 cm) in

any direction.

System Dimensions

The dimensions and footprint values for the overall system are the sum of those
for the Controller and each module. Dimensions are as follows:

Module

Width/Height/Depth

Controller

24 x 371 x 31.7 inches
(61 x94.2 x 80.5cm)

Standard PB8500 Module

10 x 50.3 x 26.9 inches
(25.4 x 127.8 x 68.3 cm)

Input and Output Modules
(The final Output module has an

end panel that makes the module N

inches wide.)

10 x 42 x 33.7 inches
(25.4 x 106.7 x 85.6 cm)

Pretreat Module

10 x 50.3 x 42.8 inches
(25.4 x127.8 x 108.7 cm)

DOD Module

50 x 53.8 x 35.3 inches
(127 x 136.7 x 89.7 cm)
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Weight

To determine the system weight, calculate the sum of the weights for each
module, the Controller, and any additional casters (11 lbs/5.0 kg).

For the weight of the controller and each module, refer to the PB8500 Passport
Issuance System data sheet on the Datacard website (www.entrust.com).
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Module Interlocks

Module interlocks are a safety feature that prevent operator injury. Lifting a
hood causes the motors to be disabled and the interlock indicator light for the
module(s) to go off. Interlock lights for the adjoining modules go off, but the
adjoining modules finish processing passports and then sit idle with motors
enabled.

Most systems have connected hoods so that all or many modules lose power to
the motors when hoods are opened. Wider modules have one interlock on the
upstream side.

The Output module has its own hood and a Pause/Resume switch. When the
hood is opened, motors in the upstream module are disabled. The Input module
also has its own hood. When the hood is opened, it disables the motor of the
module adjacent to it.
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Module Status Lights

Each module (except for the Input and Output modules) has a status light
located on the front panel to alert the operator when the module needs
attention. When the light is either flashing or solid on, refer to the error
message on the Controller screen for more information.

Flashing light—Module error
or failure in normal operation;
failure in module firmware.

Light on, but not flashing—
Supplies are low or the
module is in a paused state.

No light—Module is running
normally or power is off.

When a module error occurs, the other modules process their current
tasks until completed. At that point, the system enters a paused state
(all module status lights are on, but not flashing).

Module Warning Labels

When working around the system, observe the following warning and caution
labels affixed to various areas on the equipment.

Computer BIOS Battery

The motherboard in the Controller computer contains a battery backup for the
system BIOS. If the battery is improperly connected, damage to the
motherboard can result. Replace the battery with only the same or equivalent
type recommended by the manufacturer. Dispose of used batteries according
to the manufacturer’s instructions.
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Supplies

Find the current supplies information on the Entrust website

(www.entrust.com):

Datacard Home > Product & Solutions > Supplies

Related Documents

The following documents provide additional information for the PB8500

system.
Description Part No. Available on CD
PB8500 Passport Issuance 539684-001 This library
System Data Formatting Manual
PB8500 Passport Issuance 527378-001 This library
System Software Administrator’s
Guide
[llustrated Parts Manuals for Each | Mulitple This library
Module
System Safety Rules 539614-001 This library
Preventive Maintenance Tools and | --- This library

Supplies List

Datacard Certified Supplies

This library and TrustedCare

10
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Chapter 2: System Power
On and Power Off

This chapter provides,procedures for starting, stopping and
pausing the Datacard” PB8500" Passport Issuance system.

Power On the System

The system has a button for starting the Controller computer and an E-Stop
switch for powering on the system modules.

Perform the following procedure to start the system.
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Procedure

1.
2.

12

Plug the system into AC power.

Turn on the Controller PC by pressing the power button on the front of the
computer. Allow the Controller PC to boot up completely.

Do not use the keyboard or mouse during Windows start-up.

Log on to Windows.

Start the Controller software, and go to the Production screen. It displays
the progress of the system during startup and, eventually, a diagram of the
system.

Power on the system hardware by rotating the E-stop switch on the front of
the Controller module clockwise to the ON position. This switch controls all
AC power to the modules, the cooling fans, and all additional power cords
that are installed on the system.

You can use the E-stop switch to stop the system in an
emergency.

System Power On and Power Off



Power On Troubleshooting

If the system fails to start properly, use the following guidelines to isolate the
most likely cause. Some of these troubleshooting scenarios may require a
trained technician to isolate and correct the problem.

Controller Problems

If the Controller computer cannot be turned on:

o Verify that the main power cord is connected to the system and the facility
outlet.

o Verify that the facility power is available and is of the correct voltage for the
system. The system requires single-phase, grounded, 180 to 264-volt, AC
power at 47 to 63HZ.

e Make sure the power cord on the back of the Controller computer is
properly connected.

If the Controller computer starts, but does not ‘properly boot up, follow the
diagnostic procedures for Microsoft” Windows .

Module Boot Problems

If none of the modules boot up:
e Verify that the red E-Stop switch on the front of the Controller is on.

e Verify that the power cable between the Controller and the first module
(Input module) is connected.

e Verify that the Ethernet connection between the Controller computer and
the Ethernet switch is correct. Also verify that the Ethernet switch has
power.

If all modules boot up except for one, the most likely cause is a bad Ethernet
connection.

If all modules downstream from a module fail to boot up, the most likely cause
is a disconnected power jumper between modules, or an auxiliary power cord
on that module that is not plugged in to facility power.
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Power Off the System

Remove AC power from the system any time service is being performed.
1. Wait until all production tasks are complete.

2. Select the Windows Shutdown command, and wait for the Controller PC to shut
down.

3. Turn the E-Stop switch counterclockwise to OFF. The word OFF is then visible
in the dial cutout. This removes power from the following:

m  All modules
m  The system fans

s Modules that are supplied by additional power cord inlets

4. If you are performing service on the PB8500 system:
a. Unplug the power cord(s) from the AC power source.

b. Capture the female end of the AC cord into a certified lock-out device,
such as the sample shown here, and lock it with a padlock.

Each person servicing the system should have their own
personal lock.

Caution: Never remove someone else’s lock from a lockout.
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Pause and Resume the System

You can pause the system with the Controller
Pause/Resume button on the Output module.

The Pause/Resume button has a built-in light
states:

Operator’'s Guide

software, or by pressing the

that shows the following system

Green flashing light—System is
paused.

Green light on, but not flashing—
System is in the normal running or
idle state.

No light—System is temporarily
between the pause and running
state.
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Chapter 3: Load Supplies

This chapter provides procedures for loading supplies in
the Datacard’ PB8500" Passport Issuance system.

Booklets

Use the following instructions to load booklets into the Passport Input Module.
If the booklets are different stock, adjust for booklet thickness as described in

“Adjust for Change of Booklet Thickness” on page 18. If booklets are jammed in
a module, refer to instructions on page 18.

Load Booklets

Load booklets into the Passport Input Module on their sides with the spine
down and the front cover of the booklet facing the back of the module.

Operator’'s Guide 17



Adjust for Change of Booklet Thickness

When you load thicker or thinner booklet stock, you may need to adjust the
Input Module so that the booklet separator picks only one booklet at a time.

Adjustment Procedure

1. Place two booklets into the stacker and move them forward until they both
line up with the edge of the booklet separator.

2. Loosen the adjustment knob (2).

3. Move the booklet adjuster (1) forward or back until it is in the center of the
second booklet. In this position the first booklet can pass, but the second
booklet is blocked.

4. Retighten the adjustment knob (2).
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Printheads for Inkjet Modules

Printheads must be replaced by trained service personnel. This procedure is
documented in the Drop On Demand Module Service Manual
(Part No. 528211-001).

Operator’'s Guide
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Overlay Material

When the supply roll is empty, replace it with a new roll, as described below.

Replacement Procedure

1. Load the thin film overlay so that the registration mark is at the top of the
roll.
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2. Use the following figure as a guide to thread the thin film overlay through
the standard Secure Overlay Module.

Operator’'s Guide
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Chapter 4: Production

This chapter informs the user how to use the Production
application of the Controller software to monitor the
system and process jobs.

Monitor the System

The Production application in the Controller software allows you to process and
monitor jobs. You also can see the status of modules and whether supplies
need to be replaced. To customize elements of the production interface, refer
to “Production Preferences” on page 47.

* If security is enabled on your system, you might not have access to all
of the options described in this chapter. Consult your system
administrator, if needed.

* You can access the information in this chapter also in the PB8500
Controller software. Click the Help menu and select Help.

* If you upgrade your Controller software in the future, the online help
will be current with the version to which you upgrade. You can
download a more current version of this guide from
http://www.TrustedCare.com. If you do not have access to this site,
please contact your Datacard representative.

Open the Production Station

If the Production tab in the Controller software is not visible, click the
Applications menu and select Production. To open the production station, click
the Production tab. The production station provides a visual representation of
the entire system.

Module Status

In the Production tab of the Production Application, each module in the system
is represented in graphic form. Color coding shows the status of each module.
Corresponding messages display in the lower message pane.

Your system may have different modules, but the status reporting is
the same.
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e Blue indicates normal operating status.

e Yellow indicates a cautionary condition (low supplies, input passport tray
approaching empty, and so forth).

e Red indicates an error condition or an opened interlock. If an interlock is
opened, the module, controller, and both neighboring modules on the
topology turn red. When you close the interlock, the color changes to blue.

e You may right-click on a module to see a menu for resetting it.

Supply Status

The Production screen displays the status of system supplies.

e Passport trays change color depending on their fill state (white, yellow, red).
An Input tray that is running low on passports turns from white to yellow as
the supply gets low, and to red when the tray is empty. Conversely, an
Output tray is shown as red when full and white when empty.

e The Inkjet and Overlay modules have an icon with a gauge that displays the
state of the supply quantity. When the supplies are exhausted, the icon
changes and an error message displays.

e The supply type and status display when you use the mouse to roll over the
supply icons. Smart supplies display correctly, but for other supplies the
name is whatever name or names are associated with that RFID value or it is
determined by the data given to the machine.
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Job Status

You can monitor the status of individual passports within a job from the Job
Details tab. The Job Details tab has information about each passport in the
selected job. For more information, refer to “View Job Information” on page 29.

Other Status Reporting

Use the following for additional status information.
Status Bar

The status bar on the main interface has load status, production status, and
machine monitors that give visual indicators of job and machine states. For
more detailed information, refer to “Production Station Status Bar” on page 39.

Messages

Error, Warning, and Info messages appear at the bottom of the Production
screen. Click a message to see Extended Help. An example is shown below. The
filters allow you to choose the types of messages that display.

A list of all error messages is available by selecting Help > Error Messages.
Error messages are categorized by module and have unigue message numbers.
The Administrator’s library includes a printable list of all error messages.
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Event Log

The system administrator can use the Event Log tools to query and view
system events for administration and troubleshooting. The Event Log is
described in detail in the Controller software online help and the
Administrator’s Guide.

Process Jobs

The following sections describe how to use the Production application to
process passports.

Load Jobs

Follow the steps below to load job files into the database.

1. In the Production Station tab (Applications > Production), click Load on
the status bar. The Load dialog box displays.

You can select multiple job files to load contiguously. The load status
identifies the job that is loading and its percentage complete. For example,
if you load three jobs, the job load progress bar goes from 0% to 100% three
times. If you want to know which job is loading, move the cursor over the
progress bar to see the job name in the tool tip.

All selected job files must be able to use the same Job Setup.
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2. To select the job file, click Browse, navigate to the file location, and click
Open. The file path displays in the File Name text box.

Operator’'s Guide
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3. Perform one of the following steps.

m  Select the Job Setup file (click Browse, navigate to the file location, and
click Open).

or

m If selection criteria are set up, select the Use Selection Criteria check
box to let the program search through existing Job Setups (which
contain the selection criteria) to find a name that matches the job file.

e Job Setups specify which Data Setups, Production Options
Setups, Audit Setups, and Passport Setups the job uses.

e Depending on your security privileges, jobs that display in the
Ready Jobs and All Jobs tab have a right-click menu with
options to open the setups used, view the data, and export
the setups.

4. Click Load to load the job into the database. The job displays in the Ready

Jobs and All Jobs lists. You can view the load status monitor on the status
bar to see the load completion percentage.

To run a loaded job, refer to “Run Jobs” on page 28.

Run Jobs

28

After loading one or more jobs, use the following procedure to run them.

1.

2
3.
4

Open the Production window (Applications > Production).
Click the Ready Jobs tab.
Select the job. You can select multiple files to run contiguously.

Click Start.

*  You can click and drag using your mouse and use Alt+Click or
Shift+Click to select multiple jobs.

* If ajob has any rejected passports, or has passports that were
previously held and are now not held, select that job and then
click Remake to run the job again.

* Do not attempt to remove any books until the machine is
paused and a message appears notifying you that it is OK to
do so.

Production



User Input Needed Dialog

If you have the Vision Verification or Quality Assurance module, the User Input
Needed dialog box displays if a quality issue is detected by one of these
modules. The message prompts you to take some action to make sure that the
job completes successfully. Production does not continue until you take action.
You can click the Override check box to continue for this production run if
needed.

View Job Information

When a job is running, perform the following steps to view information about
that job.

1. In the Production Station (Applications > Production), select the All Jobs
tab.

2. Select the running job.

3. Click the Job Details tab (you also can click View Details). The Job Details
tab provides information to monitor (in real time) the status of individual
passports within a job. For detailed information, refer to “Job Details Tab”
on page 43.

4. To see error messages related to the job, click the Production tab. Messages
display at the bottom of the screen. You can select the check box next to
the message types (Error, Caution, Information) that you want to view in
the message pane.

5. Double-click a status message to view details about that message.

There might be a delay between the time you select a function
button and the time when the system is ready for another input.
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Preview Products

30

Print preview from the Job Details tab allows you to proof a passport before it
is produced. The preview shows printable graphics information such as image,
text, and bar code elements. You can view non-printable information such as

chip data in the Job Details screen.

Print Preview is not available when data is encrypted.

Perform the following procedure to access Print Preview from Job Details.

1.

2
3.
4

Open the Production window (Applications > Production).
Select the job in the All Jobs or Ready Jobs tab.
Click the Job Details tab.

Select a single record or multiple records. If you select multiple records, the

passports display in the order of their record number.

Production



5. Use one of the following to open the print preview window.

m  Right-click on the selected records and then select Print Preview.

or

s Click the Print Preview button.

If more than one record is selected in the table to preview, the
row is highlighted in light blue to correspond with the record
being previewed in the Print Preview window.

If the Passport Setup is changed after loading the job or running
the job, the preview might not match the printed passport.

Operator’'s Guide
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The following table describes the print preview properties on the Front, Back,
and Both Sides tabs.

Front/Back/Both Sides Tabs Properties

The “Virtual View the passport as designed in Passport Setup. Only
Passport” image, text, and bar code elements display.

Zoom Select the zoom level to view greater or less detail.
Rotation Select Rotation to turn the passport clockwise in

increments of 90 degrees.

Show Select the check box to display the background image (if

Background any). The background image is associated with the
selected passport stock as defined in Stock
Management.

Auto Refresh Select the check box to refresh the preview image

automatically when any change occurs to the image,
text, or bar code elements. A decrease in performance
might occur if many changes are being made.

Refresh Click to refresh the preview image.

Page Use the navigation buttons to scroll through pages in the
book. The single arrow button (>) increments or
decrements by one, the double arrow button (>>)
increments or decrements by 10, and the final button (>|)
jumps to the beginning or end of the record list.

Slide Show Click the forward or reverse buttons to scroll through the
product records. Click the stop button to stop the slide
show.
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Remake a Job

Use the following procedure to remake passports that were rejected.

1. In the Production window (Applications > Production) under the All Jobs
tab, select the job from the list.

2. Select the Job Details tab. The Job Details screen contains a list of all
passports in a selected job.

3. If any passports have been rejected, click Remake in the status bar to
remake those passports.

You can click and drag using your mouse and use Alt+Click or
Shift+Click to select multiple passports.

4. Click Refresh to update the screen manually.

Pause/Stop/Abort Jobs

When a job is running, perform the following steps on the Production screen to
stop, pause, or cancel the job.

1. In the Production window (Applications > Production), select the
Production tab.

2. Select one of the following:

= Pause
Use Pause to stop the job temporarily. Click Resume to continue.

= Stop
Use Stop if you want to restart at a later date. The system finishes any
passports that are already in the track. Click Start when you want to
finish the job (make sure the correct job is selected).

¢+ If the auto-remake function is enabled and an error is encountered,
click Stop (No Pick) to stop the job and prevent the system from
initiating a remake on the passport that caused the error.

¢+ If you select Stop (No Pick), you can click Remake in the Job Details
tab when you are ready to remake the rejected passports from the
last job.

= Abort
Use Abort to cancel the job and clear the passports out of the track. No
remake or error recovery OCCurs.
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Split Jobs

Use the following procedure to create multiple jobs from a single job. For
example, if a job contains 1000 passports, you can split it into smaller jobs. You
can split a job into two jobs at a specific passport or form, or you can split a job
into multiple jobs of equal size.

You also can select individual passports to split into a different
job. Refer to “Advanced Split” on page 35.

1. In the Production window (Applications > Production) under the Ready
Jobs or All Jobs tab, select the job that you want to split.

2. Click Split on the bar above the job list. The Split dialog box displays the job
name and job size.

3. To split one job into two jobs:

a. Click Split before passport #.

b. Enter the passport number that you want to be the first in the new job. If
the job contains 1000 passports and you enter the number 301, the job is
split into two jobs—one with 300 passports and one with 700 passports.
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c. Click OK. The new job is created and added to the job lists. The new job
has the same name as the current job with “[O01]” appended.

4. To split a job into multiple jobs:
a. Click Split into jobs of passport quantity.

b. Enter the number of jobs that you want. The passports are split equally
between jobs.

If the number of passports is not evenly divisible by the
number of jobs, the resulting jobs contain an equal number,
except for the final job, which contains the remaining
passports.

c. Click OK. The new jobs are created and added to the job lists. The new
jobs have the same name as the current job with “[O01], [002]”, and so
on appended.

Advanced Split

An advanced split allows you to specify individual passports within a job to split
into a separate job.

1. In the Production window (Applications > Production), under the Ready
Jobs or All Jobs tab, select the job that you want to split.

2. Click the View Details button or Job Details tab.

3. Select the passports you want to split from the job.

You can click and drag using your mouse or use Alt+Click or
Shift+Click to select multiple passports.

4. Click Advanced Split on the right side of the toolbar.

5. In the confirmation dialog box, verify that you want to split the job and click
OK. The new job is created and added to the job lists.
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Search for Jobs

Perform the following steps to search for jobs within the database:

1. In the Production window (Applications > Production), select the All Jobs
tab.

2. In the left pane, select the check box next to the parameters on the jobs list
that you want to use in your search. The more you select, the narrower the
scope of the search.

Name - Enter the name of the job in the text box.

State - Select the state from the list. The program displays only the jobs
with the selected status.

Total Passports - Enter the total passports in the job. Enter a number in
the text box and then select a quantitative indicator (less than, more
than, equal to, and so forth) from the list. For example, to display only
jobs that have 500 or more passports, enter 500 in the text box and
select the greater-than-or-equal-to (>=) sign from the list.

Created - Enter a number in the text box and then select Hours or Days
from the list. For example, if you enter 5 and select Days, only the jobs
created in the past five days display.

Last Worked On - Enter a number in the text box and then select Hours
or Days from the list. For example, if you enter 8 and select Hours, only
the jobs worked on during the past eight hours display.

Job Setup - Select Browse, and then select a Job Setup from the dialog
box. The program displays only the jobs that use the selected Job Setup.

Input File - Enter the Input File name into the text box. The program
displays only the jobs that use the listed Input File.

Has Rejected Products - Select to display only the jobs that contain
rejected products.

Has Held Products - Select to display only the jobs that contain held
products display.

3. Click Search to initiate the process. The top area of the left pane changes to
reflect your search.

Click Clear to clear all parameters and display all jobs in the list.
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Hold/Reject Passports from a Job

Perform one of the following procedures to hold, reject, or remove a product
from a job.

1.

In the Production window (Applications > Production) under the All Jobs
tab, select a job from the list.

Select the Job Details tab. The Job Details screen contains a list of all
passports in the selected job.

To reject a passport or passports from the job:
m Select a passport or passports from the list.

m Click Set Reject on the upper bar to reject the passport manually. (The
passport must first have been processed successfully in order to be
rejected manually.)

To override the “Reject” status, select any rejected passports from the list,
and then click Set Good.

To hold a passport or passports from being processed when the job runs:
m  Select a passport or passports from the list.
s Click Hold on the upper bar.

m To release the hold, select any passports with a "Hold" status from the
list, and then click Release Hold.

Delete Jobs

Perform the following steps to delete a job permanently from the database.

1.

38

In the Production window (Applications > Production), select the All Jobs
tab.

Select a job or jobs from the list, and then click Delete Job on the upper bar
to remove the job(s) permanently from the database.

*  You cannot select non-consecutive multiple jobs.
* When ajob is deleted, so is the Audit Report backup.

* Deleting a job cannot be undone.
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Production Station Reference

The Production interface includes bars and tabs that display information job

screens.

Production Station Status Bar

The status bar is viewable regardless of the tab displayed.

To customize elements of the Production interface, refer to “Production
Preferences” on page 47. Each operator can customize fonts and font sizes for
tool bars, tables, and other elements. You also can activate FIR data views and
tooltips to display at the bottom of job screens.

The status bar on the Production application contains the following:

Indicator

Description

Load and Cancel
Load buttons and the
load status bar

The Load button loads a job into the database. One job
can be loaded at a time. When a job is loading, the Load
status bar gives a visual percentage of the job loaded. A
Cancel Load button stops the job loading process.

Production status bar

The Production status bar gives a visual percentage of job
completion as well as the speed of the job in passports

per hour.

Machine status

The Machine status monitor provides the current state of
the system. The machine states are as follows:

Idle There is no activity in the system.

Pausing Production is in the process of pausing.

Paused Production has paused.

Stopping Production is in the process of being
stopped.

Busy The system is in the production process.

Offline The system has been taken offline or

production is initializing.
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Indicator Description

Hood status The Hood status indicates whether opening the hood is
allowed (OK to Open Hood or Do Not Open Hood). The
hood status is red when it is NOT OK to open the hood.

Audit On or Off Audit ON is green when audit data is being collected.

Open Applications Bar

The lower bar has program tabs on the left side that display all open
applications. Click a tab to bring that application window to the top.

Ready Jobs Tab

The Ready Jobs tab displays a table of all loaded jobs that have not been run or
that have at least one rejected passport. You can right-click a job to open a
menu with options for opening the corresponding setups or the Export Setups
utility, or for viewing data. For more information about displaying jobs, refer to
“Group Jobs” on page 47.
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The information that displays in the Ready Jobs tab depends on the fields
defined in Data Setup and the columns selected. Following is an example. Refer
to “Choose Columns to Be Displayed” on page 45.

Column Description
Name The name of the job
Split Number The split number if the job has been split (the resulting

jobs are numbered sequentially)

Total Passports

The total number of passports in the job

Good Passports

The number of good passports in the job (supplied only if
the job has rejects)

Reject Passports

The number of rejected passports (supplied only if the
job has been run)

Held Passports

The number of held passports (not processed)

Status The status of the item: None, Good, or Rejected
Input Flle The Input file used for this job
All Jobs Tab

The All Jobs tab displays a list of all loaded jobs of any status. The information
that displays depends on the fields defined in Data Setup and the columns
selected. Following is an example. Refer to “Choose Columns to Be Displayed”
on page 45. To use the Job Grouping feature, refer to “Group Jobs” on page 47.

Column Description
Name The name of the job
Split Number The split number if the job has been split (the

resulting jobs are numbered sequentially)

Total Passports

The total number of passports in the job

Good Passports

The number of good passports in the job (supplied
only if the job has been run and contained rejects)

Reject
Passports

The number of rejected passports (supplied only if
the job has been run)

Held Passports

The number of held passports (not processed)

Operator’'s Guide
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Column Description

Status The job status
Input File The Input file used for this job
Filtering Tool

42

The All Jobs tab includes a filtering tool for quickly locating jobs based on their
parameters. Use the filtering tool to define specific criteria to speed up the
search.

Follow these steps to search for jobs:

1.

In the left pane, select the check box next to the parameters to use in the
search. The search filter parameters are listed in the following table. The
more parameters you select, the narrower the scope of the search. Enter the
required information for each parameter selected.

2. Click Search. The top area of the left pane changes to reflect search
parameters.
Click Clear to clear all parameters and display all jobs in the
system.

Search Filter Description

Parameter

Name Enter the name of the job in the text box.

Status Select the status from the list. The program
displays only those jobs with the selected status.

Total Passports Enter the total number of passports in the job.
Enter a number in the text box and select a
quantitative indicator (less than, more than, equal
to, and so forth) from the list.

Example: If you enter 500 and select >= from the
list, the program displays only jobs that have 500
or more passports.

Created Enter a number in the text box and then select
Hours or Days from the list. For example, if you
enter 5 in the text box and select Days from the
list, the program displays only jobs created in the
past five days.
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Search Filter
Parameter

Description

Last Worked On

Enter a number in the text box and select Hours or
Days from the list.

Example: If you enter 8 in the text box and select
Hours from the list, the program displays only jobs
worked on during the past eight hours.

Job Setup Select Browse, and then select a Job Setup from
the dialog box. The program displays only jobs that
use the selected Job Setup.

Input File Enter the Input File name into the text box. The

program displays only jobs that use the listed Input
File.

Has Rejected Products

If selected, the program displays only jobs that
contain rejected products.

Has Held Products

If selected, the program displays only jobs that
contain held products.

Job Details Tab

The Job Details tab in the Production area provides information to monitor (in
real time) the status of individual passports within a job.

The information that displays depends on the fields defined in Data Setup and

the columns selected. The following is an example. To change the columns that

display, refer to “Choose Columns to Be Displayed” on page 45.

Column Description

Record Number The number of the record within the job

State The current state (Unprocessed, and so forth)
Status The job status (Ready, Completed, and so forth)
Held The number of held passports (not processed)
Number of The number of attempts to process the job
Attempts

Passport Setup The Passport Setup file used for this job
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Print Preview

Select one or more records in the Job Details tab and select the Print Preview
option to preview the selected records (print preview is also available from the
right-click menu). Refer to “Preview Products” on page 30 for more
information.

Sort and Filter Records in the Job Details Tab

In the Job Details tab, you can sort the records by column heading and filter
the records shown in the list.

Filtering categories (record number, state, status, etc.) are defined in
the Data Setup.
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Sort by Table Heading

To enable records to be sorted by column head, click Allow Table Sorting in the
Job Details tab. This setting is saved in the user preference file.

Do not sort tables during a production run with a large
number of passports, as this causes delays in production
times.

Filter by Production Counts

Click a Production Count folder to view only the passports in that folder. For
example, to view only the rejected passports from a specific job, click the
Reject folder. (The number in parentheses to the right of the folders is the
number of passports contained in that folder.)

Filter by Record Number

If the selected job contains a large number of passports, use the filter tool to
limit the number of passports displayed. The tool consists of a list of record
numbers that you can filter with the range parameters at the bottom of the Job
List pane.

For example, to view records 2700 to 2800 of a job that contains 10,000
passports, select Record No. from the list, enter the range (2700, 2800) in the
Range box, and then click Search. Click Clear to clear the search results and
display the full job details.

To search for a single record, select Record No. from the list and then enter the
record number in the first of the two range fields and click Search. Click Clear
to clear the search results and display the full job details.

Choose Columns to Be Displayed

Use Choose Columns to select the columns to be displayed on the Ready Jobs,
All Jobs, or Job Details tabs of the Production station.

Your system administrator sets privileges for this option.

Follow the steps below to view or hide columns:

1. Select the Ready Jobs, All Jobs, or Job Details tab.
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2. Click Choose Columns.

3. Add or remove column types from the Selected Columns box by using the
arrow buttons.

To select multiple column types, use Shift+Click or Alt+Click.

Production



4. Click Set to Default to return to the default setting.

5. Click OK when finished, or Cancel to exit without making changes.
Group Jobs

The Ready Jobs and All Jobs tabs can group jobs by group name or input file
(jobs that have been loaded from the same input file) into a single display item.
Select an option from the Group by list. The job group becomes a separate row
in the table. You can expand and collapse the job group to show or hide the
jobs contained in the group.

If an input file is loaded multiple times, all jobs that use this
file are grouped together, whether they are related or not.

Job groups display in sorted order (alphabetical by input file name). You can

use the sort indicator control in the Input File column to reverse the order of

the groups. Within each job group, the jobs are initially sorted by create time,
but can also be sorted by other fields.

Production Preferences

Production preferences are set and stored for each operator. To use the
Production Preferences Tool, select Tools > Preferences from the menu bar.

Customization can include the text in tables, tabs, buttons, tool bars, and
extended help. There is also a tool tip option and a setting for viewing FIR
record data in the interface.
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Each tab in the tool has options for customizing Production interface elements
(font, font size, FIR data, and tool tip views). Each tab has the following
buttons:

OK - Applies changes, Saves, and closes the dialog.
Cancel - Closes the dialog, no changes are applied.
Apply - Applies changes, Saves, and the dialog box continues to display.

Use Defaults - Resets all settings to the default.

General Tab

Use the General tab to select the appearance of the elements in the Production
tab of the Production Station interface.
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Use the General tab to set the font and font size for interface elements
including: the text of the Production tabs (1in the following figure), Production
Statistics (2), Display Fields (3), and Extended help titles and text (4). You also
can enable and customize Table Tool Tips (5) that display when the pointer
hovers over a cell in a table.
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Toolbars Tab

Use the toolbar tab to select the font and font size for the toolbar buttons on
the Production interface tabs and View Accounts dialog. You can use common
settings for all toolbars or set the toolbars individually.

50 Production



Tables Tab

Use the Tables tab to set the font and font size for the tables on the Production
interface tabs and View Accounts dialog.

The font and font size changes apply to the table column headings and table
values. You can use common settings for all tables or set the tables individually.
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FIR Record Tab

Use the FIR Record tab to enable FIR data to display at the bottom of the
Production interface tabs with customized sizing and the tool tip option. You
can set the font and font size for the FIR data view as well as the tool tip. You
can set common preferences for all tabs, or set the tabs individually.
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Chapter 5: Preventive
Maintenance

This chapter provides routine preventive maintenance
schedules and procedures for periodic cleaning and
inspection of the Datacard” PB8500" Passport Issuance
system.

Overview

PB8500 systems require routine preventive maintenance to optimize
performance and minimize downtime. Perform preventive maintenance
procedures either at specified time intervals or machine-cycle intervals,
depending on the module. In addition, perform preventive maintenance after
any of the following activities:

¢ Replacing any module, assembly, sub-assembly, or adjustable part
e Performing any unscheduled maintenance

The preventive maintenance procedures in this manual are to be
performed by operators or other properly trained on-site personnel.
Tasks intended for service personnel are documented in the
individual PB8500 module service manuals.

Cleaners, Tools, and Supplies

The cleaners, tools, and supplies required to meet the PB8500 system
preventive maintenance requirements are listed the Preventive Maintenance
Tools and Supplies List on the CD library menu.
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System Preventive Maintenance Tasks

Site personnel need to perform the following preventive maintenance tasks.

Warning: Before performing maintenance, power off the Controller and

remove the AC power cords. Refer to “Power Off the System” on
page 14.

Procedure

Frequency

Comments

Vacuum all
booklet tracks

Once per
week or every
25,000 books

e Check for debris in both upper and lower
guides.

e Vacuum the area to remove dust and
debris as necessary.

Clean track
sensors

Once per
week or every
25,000 books

Vacuum or wipe the sensors with a dry, soft
cloth or cotton swab.

e This includes all entry and exit sensors.

e This excludes all tabbed belt sensors and
fiber optic sensors.

Caution: Do not use alcohol to clean
the sensors.

Vacuum the
upper half of the
system

Once per
week or every
25,000 books

Vacuum dust and debris from the module
platform area (above the frame only).

Caution: Never vacuum near circuit
boards or electronic devices.

Clean transport
rollers

Once per
week or every
25,000 books

Wipe the roller surfaces with a soft cloth
dampened with isopropyl alcohol.

Clean the camera
lenses and
mirrors

Weekly or as
needed

1. Use compressed canned air to remove
dust and debris.

2. Use optical cleaning fluid and optical
cleaning tissue if necessary.
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Procedure

Frequency

Comments

Clean the exterior
components of
the Controller

As needed

1. Clean the monitor with a soft cloth
dampened with water. Immediately wipe
the monitor dry with a clean cloth. Refer
to the monitor’s manual for more specific
instructions.

2. Vacuum the keyboard. If necessary, wipe
the keys with a cloth dampened with
water. Never let liquids spill on the
keyboard.

3. Remove the track ball from the mouse
and wipe with a lint-free cloth.

4. Wipe the outside of the whole system
with a clean cloth dampened in a mild
detergent.

Clean the
Controller module
filter (also the air
filter on the
Output module, if
present)

Monthly

Clean the filter over the fans on the side of
the Controller whenever it gets dirty, and at
least once per month.

Pull the flexible filter away from the
Controller and vacuum it on both sides.
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Chapter 6: Troubleshooting

This chapter provides troubleshooting procedures that the
operator can perform.

Reset the Controller or a Module

To reset only the Controller or a specific module, use the following procedure.

1.
2.

Make sure that there are no jobs are running and that the system is idle.

In the Production tab of the Controller software, right-click the Controller or
module and select Reset.

Reset the System

If you need to reset the system by powering off the Controller PC, use the
following procedure.

1.
2.

Make sure that there are no jobs are running and that the system is idle.

Remove power from the modules by shutting off the red E-Stop power
switch.

Shut down the PB8500 Controller software.
a. From the Main window, open the File menu and select Exit.
Shut down the Windows operating system.

a. Wait 2 to 5 minutes and then power up only the Windows operating
system.

If the PB8500 software does not automatically open, click on the
PB8500 icon.

Go to the Production tab.

When the machine has reached at least 11% of startup, use the red E-Stop
power switch to power up the modules.
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Remove Jammed Booklets

The PB8500 system is designed to recover automatically from booklet jams.
However, if automatic recovery is unsuccessful, use the following procedures to
remove the booklets.

You can remove a jammed booklet directly from a module without affecting
other modules.

Be careful to avoid damaging the belt’s tab when you move the
booklet back into a module. Move the belt by rotating the pulley. Do
not push back against the tab itself.

Do not touch the camera lens or the laser lens—fingerprints and
scratches on the lenses can lead to faulty vision or laser results
(including total or regional density variation, reflections, etc.). Only
trained personnel should clean the lenses. Improper cleaning
(improper cloths or tissues, improper cleaning fluid, etc.) irreversibly
damages the lens and/or lens coating.

Do not tamper with the camera position. The camera alignment is
very sensitive. Do not lean on the metal shield over the camera.
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Page Turning Module

If the booklet is still closed when it gets jammed in the Paging module, use the
following procedure to remove it.

1.
2.

Lift the module hood.

Push the back plate down and remove the booklet from the rear.

Caution: Be careful not to wrinkle or rip the booklet when removing.

3.

Rehome the back plate.

Booklet Opener Module

1.
2.

Lift the module hood.

Use your hand to pull back the horizontal guide and pull the booklet out
towards you.

If necessary, turn the pulleys on the entry assembly to advance the booklet
into the middle of the module so it can be pulled out.

Multi-Book Chip Module

1.

2
3.
4
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Lift the module hood.
Turn leadscrew to gain access to jammed booklet.
Remove jammed booklet from right side of coupler assembly.

Using leadscrew, return the coupler assembly to the home position.
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Laser 450G Module

Use the following procedure to extract a jammed booklet from the Laser
module.

1. Lift the module hood.
2. Lift the laser chamber cover.

3. Rotate the upper booklet guide assembly (1) for clearance to remove the
booklet.

4. Remove the booklet (2) from the frame and remove the booklet from the
module
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Secure Overlay

Use the following procedure to extract a jammed booklet from the Secure
Overlay module.

1. Lift the module hood.
2. If necessary, manually push the platen carriage away from the booklet jam.

Warning: Always allow the platen assembly to cool or wear
protective gloves before handling the platen shoe or internal
components. Press on the sides of the perforated guard shield when
moving the platen carriage.

3. Use your hand to dislodge the jammed booklet.

Caution: Be careful not to wrinkle or rip the supply material. If
necessary, add some slack to the supply material with the take-up
capstan knob.

4. Use the green booklet advance knobs to move the booklet out of the Secure
Lamination module.

m [If the booklet is near the entry-side of the module, turn the input roller
knob counterclockwise to push the booklet into the upstream module.
Refer to (1) in the figure below.

n If the booklet is near the exit-side of the module, turn the tabbed belt
knob (2) counterclockwise to push the booklet into the downstream
module.

5. Remove the booklet from the system.
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Buffer/Closer/QA Module

Use the following procedure to extract a jammed booklet from the Closer or
Verification module.

1. Lift the module hood.

2. Use your hand to dislodge the jammed booklet. Move the booklet near the
closing area of the booklet track. Refer to (1) in the figure below.

3. Lift the hinged track guide to release the horizontal opened cover of the
booklet (2).
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4. Pull the horizontal cover of the booklet down and toward the front of the
module (3). Slide the vertical cover out of the upper retaining clip.

Caution: Always remove booklets from the bottom, or binding
edge. Pulling the booklet from the top can damage the booklet
retaining clip.

5. Remove the jammed booklet from the module.
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